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Introduction      1

Introduction

You made the right choice twice: macOS Mojave (version 10.14) and this 
book. Take a deep breath and get ready to have a rollicking good time. 
That’s right. This is a computer book, but it’s fun. What a concept! Whether 

you’re brand spanking new to the Mac or a grizzled Mac vet, I guarantee that 
reading this book to discover the ins and outs of macOS Mojave will make every-
thing easier. The publisher couldn’t say as much on the cover if it weren’t true!

About This Book
This book’s roots lie with my international best seller Macintosh System 7.5 For 
Dummies, an award-winning book so good that long-deceased Mac clone-maker 
Power Computing gave away a copy with every Mac clone it sold. macOS Mojave For 
Dummies is the latest revision and has been, once again, completely and thoroughly 
updated to include all the tasty goodness in macOS Mojave. In other words, this 
edition combines all the old, familiar features of dozens of previous editions — 
but is once again updated to reflect the latest and greatest offering from Apple as 
well as feedback from readers.

Why write a For Dummies book about Mojave? Well, Mojave is a big, somewhat 
complicated personal-computer operating system. So, I made macOS Mojave For 
Dummies a not-so-big, not-too-complicated book that shows you what Mojave is 
all about without boring you to tears, confusing you, or poking you with sharp 
objects.

In fact, I think you’ll be so darned comfortable that I wanted the title to be macOS 
Mojave Made Easy, but the publishers wouldn’t let me. Apparently, we Dummies 
authors have to follow some rules, and using Dummies in this book’s title is one 
of them.

And speaking of dummies — remember, that’s just a word. I don’t think you’re a 
dummy at all — quite the opposite! My second choice for this book’s title was 
macOS Mojave For People Smart Enough to Know They Need This Book, but you can just 
imagine what Wiley thought of that.



The book is chock-full of information and advice, explaining everything you need 
to know about macOS Mojave in language you can understand — along with time-
saving tips, tricks, techniques, and step-by-step instructions, all served up in 
generous quantities.

Another rule we Dummies authors must follow is that our books cannot exceed a 
certain number of pages. (Brevity is the soul of wit, and all that.) So, while I wish 
I could have included some things that didn’t fit, I feel confident you’ll find what 
you need to know about macOS Mojave in this book.

Still, a few things bear further looking into, such as these:

»» Information about many of the applications (programs) that come 
with macOS Mojave: An installation of macOS Mojave includes more  
than 50 applications, mostly located in the Applications and Utilities folders. 
I’d love to walk you through each one of them, but that would have required 
a book a whole lot bigger, heavier, and more expensive than this one.

I brief you on the handful of bundled applications essential to using macOS 
Mojave — namely, Calendar, Contacts, Messages, Mail, Safari, Siri, TextEdit, 
and the like — as well as several important utilities you may need to know 
how to use someday.

»» Information about Microsoft Office, Apple lifestyle and productivity apps 
(iMovie, Numbers, Pages, and so on), Adobe Photoshop, Quicken, and 
other third-party applications: Okay, if all the gory details of all the bundled 
(read: free) macOS Mojave applications don’t fit here, I think you’ll understand 
why digging into third-party applications that cost extra was out of the 
question.

»» Information about programming for the Mac: This book is about using 
macOS Mojave, not writing code for it. Dozens of books — most of which are 
two or three times the size of this book — cover programming on the Mac; 
this one does not.

Within this book, you may note that some web addresses break across two lines of 
text. If you’re reading this book in print and want to visit one of these web pages, 
simply key in the web address exactly as it’s noted in the text, pretending as 
though the line break doesn’t exist. If you’re reading this as an e-book, you’ve got 
it easy — just click the web address to be taken directly to the web page.
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Foolish Assumptions
Although I know what happens when you make assumptions, I’ve made a few 
anyway.

First, I assume that you, gentle reader, know nothing about using macOS  — 
beyond knowing what a Mac is, that you want to use macOS, that you want to 
understand macOS without having to digest an incomprehensible technical man-
ual, and that you made the right choice by selecting this particular book. And so 
I do my best to explain each new concept in full and loving detail. Maybe that’s 
foolish, but . . . that’s how I roll.

Oh, and I also assume that you can read. If you can’t, ignore this paragraph.

Icons Used in This Book
Little pictures (icons) appear off to the left side of the text throughout this book. 
Consider these icons miniature road signs, telling you a little something extra 
about the topic at hand. Here’s what the different icons look like and what they all 
mean.

Look for Tip icons to find the juiciest morsels: shortcuts, tips, and undocumented 
secrets about Mojave. Try them all; impress your friends!

When you see this icon, it means that this particular morsel is something that 
I think you should memorize (or at least write on your shirt cuff).

Put on your propeller-beanie hat and pocket protector; these parts include the 
truly geeky stuff. It’s certainly not required reading, but it must be interesting or 
informative, or I wouldn’t have wasted your time with it.

Read these notes very, very, very carefully. (Did I say very?) Warning icons flag 
important cautionary information. The author and publisher won’t be responsible if 
your Mac explodes or spews flaming parts because you ignored a Warning icon. Just 
kidding. Macs don’t explode or spew (with the exception of a few choice PowerBook 
5300s, which won’t run Mojave anyway). But I got your attention, didn’t I?

Well, now, what could this icon possibly be about? Named by famous editorial 
consultant Mr. Obvious, this icon highlights all things new and different in macOS 
Mojave.
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Beyond the Book
In addition to what you’re reading right now, this product also comes with a free 
access-anywhere Cheat Sheet that provides handy shortcuts for use with macOS 
Mojave, offers my backup recommendations, and more. To get this Cheat Sheet, 
simply go to www.dummies.com and type macOS Mojave For Dummies Cheat Sheet 
in the search box.

Where to Go from Here
The first few chapters of this book are where I describe the basic things that you 
need to understand to operate your Mac effectively. If you’re new to Macs and 
macOS Mojave, start there.

macOS Mojave is only slightly different from previous Mac operating systems, and 
the first part of the book presents concepts so basic that if you’ve been using a 
Mac for long, you might think you know it all — and okay, you might know most 
of it. But remember that not-so-old-timers need a solid foundation, too. So here’s 
my advice: Skim through stuff you already know and you’ll get to the better stuff 
sooner.

I would love to hear how this book worked for you. So please send me your 
thoughts, platitudes, likes and dislikes, and any other comments. Did this book 
work for you? What did you like? What didn’t you like? What questions were unan-
swered? Did you want to know more (or less) about something? Tell me! I have 
received more than 100 suggestions about previous editions, many of which are 
incorporated here. So please (please!) keep up the good work! Email me at 
Mojave4Dummies@boblevitus.com. I appreciate your feedback, and I try to 
respond to all reasonably polite email within a few days.

So what are you waiting for? Go! Enjoy the book!
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IN THIS PART . . .

Find the most basic of basics, including how to turn on 
your Mac.

Make the dock work harder for you.

Get a gentle introduction to Finder and its desktop.

Find everything you need to know about Mojave’s 
windows, icons, and menus (oh my)!

Get all the bad puns and wisecracks you’ve come 
to expect.

See all of Mojave’s myriad new Finder features in one 
chapter!

Discover a plethora of Finder tips and tricks to make 
life with Mojave even easier (and more fulfilling).
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Chapter 1
macOS Mojave 101 
(Prerequisites: None)

Congratulate yourself on choosing macOS Mojave 10.14, the 15th release of 
the venerable operating system (OS) formerly known as OS X. Congratulate 
yourself for scoring more than just an OS upgrade. See, macOS Mojave 

includes a few new features that make using your Mac even easier, plus hundreds 
of tweaks to help you do more work in less time.

In this chapter, I start at the very beginning and talk about macOS in mostly 
abstract terms; then I move on to explain what you need to know to use macOS 
Mojave successfully.

If you’ve been using macOS (formerly OS X) for a while, most of the information 
in this chapter may seem hauntingly familiar; a number of features that I describe 
haven’t changed in years. But if you decide to skip this chapter because you think 
you have all the new stuff figured out, I assure you that you’ll miss at least a 

IN THIS CHAPTER

»» Understanding what an operating 
system is and is not

»» Turning on your Mac

»» Getting to know the startup process

»» Turning off your Mac

»» Avoiding major Mac mistakes

»» Pointing, clicking, dragging, and other 
uses for your mouse

»» Getting help from your Mac
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couple of things that Apple didn’t bother to tell you (as if you read every word in 
macOS Help — the only user manual Apple provides — anyway!).

Tantalized? Let’s rock.

Gnawing to the Core of macOS
The operating system (that is, the OS part of macOS) is what makes your Mac a 
Mac. Without it, your Mac is nothing but a pile of silicon and circuits — no smarter 
than a toaster.

“So what does an operating system do?” you ask. Good question. The short answer 
is that an OS controls the basic and most important functions of your computer. 
In the case of macOS and your Mac, the operating system

»» Manages memory

»» Controls how windows, icons, and menus work

»» Keeps track of files

»» Manages networking and security

»» Does housekeeping (No kidding!)

Other forms of software, such as word processors and web browsers, rely on the 
OS to create and maintain the environment in which they work their magic. When 
you create a memo, for example, the word processor provides the tools for you to 
type and format the information and save it in a file. In the background, the OS is 
the muscle for the word processor, performing the following crucial functions:

»» Providing the mechanism for drawing and moving the onscreen window in 
which you write the memo

»» Keeping track of the file when you save it

»» Helping the word processor create drop-down menus and dialogs for you to 
interact with

»» Communicating with other programs

»» And much, much more (stuff that only geeks could care about)

So, armed with a little background in operating systems, take a gander at the next 
section before you do anything else with your Mac.
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One last thing: As I mention in this book’s Introduction (I’m repeating it here in 
case you normally don’t read introductions), macOS Mojave comes with more 
than 50 applications in its Applications and Utilities folders. Although I’d love to 
tell you all about each and every one, I have only so many pages at my disposal.

THE MAC ADVANTAGE
Most of the world’s personal computers use Microsoft Windows (although more and 
more people are switching to the Mac). But you’re among the lucky few to have a com-
puter with an OS that’s intuitive, easy to use, and (dare I say?) fun. If you don’t believe 
me, try using Windows for a day or two. Go ahead. You probably won’t suffer any per-
manent damage. In fact, you’ll really begin to appreciate how good you have it. Feel free 
to hug your Mac. Or give it a peck on the mouse or trackpad.

As someone once told me, “Claiming that macOS is inferior to Windows because more 
people use Windows is like saying that all other restaurants serve food that’s inferior to 
McDonald’s.”

We might be a minority, but Mac users have the best, most stable, most modern all- 
purpose operating system in the world, and here’s why: Unix, on which macOS is based, 
is widely regarded as the best industrial-strength operating system on the planet. For 
now, just know that being based on Unix means that a Mac running macOS will crash 
less often than an older (pre-OS X) Mac or most Windows machines, which means less 
downtime. Being Unix-based also means getting far fewer viruses and encounters with 
malicious software. But perhaps the biggest advantage macOS has is that when an 
application crashes, it doesn’t crash your entire computer, and you don’t have to restart 
the computer to continue working.

By the way, since the advent of Intel-powered Macs more than a decade ago, you can 
run Windows natively also on any Mac powered by an Intel processor, as I describe in 
Chapter 23. Note that the opposite isn’t true: You can run Windows on your Mac if you 
care to, but you cannot run macOS on a Dell or HP or any other computer not made by 
Apple (at least not without serious hacking, which is probably illegal anyway).

And don’t let that Unix or Windows stuff scare you. It’s there if you want it, but if you 
don’t want it or don’t care (like most users), you’ll rarely even know it’s there. In fact, 
you’ll rarely (if ever) see the word Unix or Windows again in this book. As far as you’re 
concerned, Unix under the hood means your Mac will just run and run and run without 
crashing and crashing and crashing. As for Windows, your Mac can run it if you need it; 
otherwise, it’s just another checklist item on the list of reasons Macs are better than PCs.
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A Safety Net for the Absolute  
Beginner (or Any User)

In the following sections, I deal with the stuff that macOS Help doesn’t cover — or 
doesn’t cover in nearly enough detail. If you’re a first-time Mac user, please, 
please read this section of the book carefully; it could save your life. Okay, okay, 
perhaps I’m being overly dramatic. What I mean to say is that reading this section 
could save your Mac or your sanity. Even if you’re an experienced Mac user, you 
may want to read this section. Chances are you’ll see at least a few things you’ve 
forgotten that will come in handy now that you’ve been reminded of them.

Turning the dang thing on
Okay. This is the big moment — turning on your Mac! Gaze at it longingly first, 
and say something cheesy, such as, “You’re the most awesome computer I’ve ever 
known.” If that doesn’t turn on your Mac (and it probably won’t), read on.

Apple, in its infinite wisdom, has manufactured Macs with power buttons on every 
conceivable surface: on the front, side, and back of the computer itself, and even 
on the keyboard and monitor.

So if you don’t know how to turn on your Mac, don’t feel bad; just look in the 
manual or booklet that came with your Mac. It’s at least one thing that the docu-
mentation always covers.

You don’t have that little booklet? Most Macs have the power button in the upper-
right corner of the keyboard (notebooks) or at the back of the screen (iMacs); it 
usually looks like the little circle thingy you see in the margin.

Don’t bother choosing Help  ➪    Mac Help, which opens the Help Viewer program. It 
can’t tell you where the switch is. Although the Help program is good for finding 
out a lot of things, the location of the power button isn’t among them. If you 
haven’t found the switch and turned on the Mac, of course, you can’t access Help 
anyway. (D’oh!)

Launch the Books (formerly iBooks) app and click the Book Store button (top left) 
to search its built-in store for the name of your Mac plus the word Essentials (for 
example, “MacBook Essentials,” “iMac Essentials,” or “MacBook Pro Essen-
tials”). Click the Only Show Free Titles check box near the upper-right corner of 
the Books window, and grab the free Essentials e-book with your Mac’s name, by 



CHAPTER 1  macOS Mojave 101 (Prerequisites: None)      11

Apple. At around 100 pages, this booklet isn’t in any way comprehensive, but it 
does include information you won’t find elsewhere, including where to find the 
power button on your particular Mac.

What you should see on startup
When you finally do turn on your Mac, you set in 
motion a sophisticated and complex series of 
events that culminates in the loading of macOS and 
the appearance of the macOS desktop. After a small 
bit of whirring, buzzing, and flashing (meaning 
that the OS is loading), macOS first tests all your 
hardware  — slots, ports, disks, random access 
memory (RAM), and so on. If everything passes, 
you hear a pleasing musical tone and see the taste-
ful whitish Apple logo in the middle of your screen, 
as shown in Figure 1-1.

Here are the things that you might see when you 
power-up your Mac:

»» Login screen: You might or might not see the macOS login screen, where you 
enter your name and password. If you do, press Return after you type your 
name and password, and away you go.

If you don’t want to type your name and password every time you start or 
restart your Mac (or even if you do), check out Chapter 23 for the scoop on 
how to turn the login screen on or off.

You should turn off the login screen only if you’re confident you’ll be the only 
one touching the machine. With the login screen disabled, your Mac and 
everything in it is completely available to anyone, which is usually not a good 
thing.

Either way, the desktop soon materializes before your eyes. If you haven’t 
customized, configured, or tinkered with your desktop, it should look pretty 
much like Figure 1-2. Now is a good time to take a moment for positive 
thoughts about the person who convinced you that you wanted a Mac.  
That person was right!

FIGURE 1-1: 
This is what you’ll see if 
everything is fine and dandy 
when you turn on your Mac.
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»» Blue/black/gray screen of death: If any of your hardware fails when it’s 
tested, you may see a blue, black, or gray screen.

Some older Macs played the sound of a horrible car wreck instead of the 
chimes, complete with crying tires and busting glass. It was exceptionally 
unnerving, which might be why Apple doesn’t use it anymore.

The fact that something went wrong is no reflection on your prowess as a Mac 
user. Something is broken, and your Mac may need repairs. If this is happen-
ing to you right now, check out Chapter 23 to try to get your Mac well again.

If your computer is under warranty, set up a Genius Bar appointment at your 
nearest Apple Store or dial 1-800-SOS-APPL, and a customer service person 
can tell you what to do. Before you do anything, though, skip ahead to 
Chapter 26. It’s entirely possible that one of the suggestions there will get  
you back on track without your having to spend even a moment on hold.

»» Prohibitory sign or flashing question mark in a folder: Most users eventually 
encounter the prohibitory sign or flashing question mark in a folder (as shown 
in the margin). These icons mean that your Mac can’t find a startup disk, hard 
drive, network server, or DVD-ROM containing a valid Mac operating system. 
See Chapter 26 for ways to ease your Mac’s ills.

»» Kernel panic: You may occasionally see a block of text in several languages, 
including English, as shown in Figure 1-3. This means that your Mac has 
experienced a kernel panic, the most severe type of system crash. If you 
restart your Mac and see either message again, look in Chapter 26 for a 
myriad of possible cures for all kinds of ailments, including this one.

FIGURE 1-2: 
The MacOS 

Mojave desktop 
after a brand- 
spanking-new 
installation of 

macOS Mojave.
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How do you know which version of the macOS your computer has? Simple:

1.	 Choose About This Mac from the  menu (the menu with the  symbol in 
the top-left corner of the menu bar).

A window pops up on your screen, as shown in Figure 1-4. The version you’re 
running appears just below macOS near the top of the window. Version 10.14 
is the release we know as Mojave.

If you’re curious or just want to impress your friends, you’ll might want to know 
that OS X version 10.13 was known as High Sierra; 10.12 was Sierra; 10.11 was 
El Capitan; 10.10 was Yosemite; 10.9 was Mavericks; 10.8 was Mountain Lion; 
10.7 was Lion; 10.6 was Snow Leopard; 10.5 was Leopard; 10.4 was Tiger;  
10.3 was Panther; 10.2 was Jaguar; 10.1 was Puma; and 10.0 was Cheetah.

2.	 (Optional) Click the Displays, Storage, Support, or Service tabs to see 
additional details about your Mac.

FIGURE 1-3: 
If you’re seeing 
this, things are 

definitely not fine 
and dandy.

FIGURE 1-4: 
See which  

version of macOS 
you’re running.
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3.	 Click the System Report button to launch the System Information 
application and see even more details.

The System Information app shows you even more about your Mac, including 
bus speed, number of processors, caches, installed memory, networking, 
storage devices, and much more. You can find more about this useful program 
in Chapter 25.

Shutting down properly
Turning off the power without shutting down your Mac properly is one of the 
worst things you can do to your poor Mac. Shutting down your Mac improperly 
can really screw up your hard or solid-state drive, scramble the contents of your 
most important files, or both.

If a thunderstorm is rumbling nearby, or you’re unfortunate enough to have roll-
ing blackouts where you live, you may really want to shut down your Mac and 
unplug it from the wall. (See the next section, where I briefly discuss lightning 
and your Mac.) If it’s a laptop, you can just disconnect it from its charging cable 
and continue using it if you like.

ETERNALLY YOURS . . . NOW
macOS is designed so that you never have to shut it down. You can configure it to sleep 
after a specified period of inactivity. (See Chapter 23 for more info on Energy Saver.) If you 
do so, your Mac will consume very little electricity when it’s sleeping and will usually be 
ready to use (when you press any key or click the mouse) in a few seconds. On the other 
hand, if you’re not going to be using your Mac for a few days, you might want to shut it 
down anyway.

Note: If you leave your Mac on constantly, and you’re gone when a lightning storm or 
rolling blackout hits, your Mac might get hit by a power surge or worse. So be sure you 
have adequate protection — say, a decent surge protector designed for computers —  
if you decide to leave your Mac on and unattended for long periods. See the section 
“A few things you should definitely not do with your Mac,” elsewhere in this chapter, for 
more info on lightning and your Mac. Often as not, I leave it on when I’m on the road  
so that I can access it from my laptop via remote connection. So, because macOS is 
designed to run 24/7, I don’t shut it down at night unless the night happens to be dark 
and stormy.

One last thing: If your Mac is a laptop and will be enclosed in a bag or briefcase for more 
than a few hours, turn it off. Otherwise, it could overheat — even in Sleep mode.
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To turn off your Mac, always use the Shut Down command from the  menu or 
shut down in one of these kind and gentle ways:

»» Press the power button for approximately two seconds and then click the 
Shut Down button in the Are You Sure You Want to Shut Down Your 
Computer Now? dialog.

»» On keyboards that don’t have a power key, press Control+Eject instead, and 
then click the Shut Down button that appears in the Are You Sure You Want to 
Shut Down Your Computer Now? dialog.

You can use a handy keyboard shortcut when the Shut Down button (or any 
button, for that matter) is highlighted in blue and pulsating slightly. Pressing 
the Return key is the same as clicking whichever button is highlighted.

The Are You Sure You Want to Shut Down Your Computer Now? dialog sports a 
check box option: Reopen Windows When Logging Back In. If you select this check 
box, your Mac will start back up with the same windows (and applications) that 
were open when you shut down or restarted. I think that’s pretty darn sweet, but 
you can clear the check box and disable this option if that’s not what you want!

Most Mac users have been forced to shut down improperly more than once with-
out anything horrible happening, of course — but don’t be lulled into a false sense 
of security. Break the rules one time too many (or under the wrong circumstances), 
and your most important files could be toast. The only time you should turn off 
your Mac without shutting down properly is when your screen is completely fro-
zen or when your system crashed due to a kernel panic and you’ve already tried 
everything else. (See Chapter 26 for a list of those “everything elses.”) A stubborn 
crash doesn’t happen often — and less often under macOS (formerly OS X) than 
ever before — but when it does, forcing your Mac to turn off and then back on 
might be the only solution.

A few things you should definitely  
not do with your Mac
In this section, I cover the bad stuff that can happen to your computer if you do 
the wrong things with it. If something bad has already happened to you .  .  .  .  
I know, I’m beginning to sound like a broken record, but see Chapter 26.

»» Don’t unplug your Mac when it’s turned on. Very bad things can happen, 
such as having your OS break. See the preceding section, where I discuss 
shutting down your system properly.
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Note that this warning doesn’t apply to laptops as long as their battery is at 
least partially charged. As long as there’s enough juice in the battery to power 
your Mac, you can connect and disconnect its power adapter to your heart’s 
content.

»» Don’t use your Mac when lightning is near. Here’s a simple life equation for 
you: Mac + lightning = dead Mac. ’Nuff said. Oh, and don’t place much faith in 
inexpensive surge protectors. A good jolt of lightning will fry the surge 
protector and everything plugged into it, including computers, modems, 
printers, and hubs. Some surge protectors can withstand most lightning 
strikes, but those warriors aren’t the cheapies that you buy at your local 
computer emporium. Unplugging your Mac from the wall during electrical 
storms is safer and less expensive. (Don’t forget to unplug your external 
modem, network hubs, printers, and other hardware that plugs into the wall 
as well; lightning can fry them, too.)

For laptops, disconnect the power adapter and all other cables because 
whatever those cables are connected to could fry — and fry your laptop right 
along with it. After you do that, you can use your laptop during a storm if you 
care to. Just make sure that it’s 100 percent wireless and cableless when 
you do.

»» Don’t jostle, bump, shake, kick, throw, dribble, or punt your Mac, 
especially while it’s running. Many older Macs contain a hard drive that 
spins at 5,200 revolutions per minute (rpm) or more. A jolt to a hard drive 
while it’s reading or writing a file can cause the head to crash into the disk, 
which can render many — or all — files on it unrecoverable. Ouch!

Don’t think you’re exempt if your Mac uses a solid-state drive with no moving 
parts. A good bump to your Mac could damage other components. Treat your 
Mac like it’s a carton of eggs, and you’ll never be sorry.

»» Don’t forget to back up your data! If the files on your hard drive mean 
anything to you, you must back up. Not maybe. Must. Even if your most 
important file is your last saved game of Bejeweled, you still need to back up 
your files. Fortunately, macOS includes an awesome backup utility called Time 
Machine. (Unfortunately, you need an external hard drive to take advantage 
of it.) So I beg you: Please read Chapter 24 now, and find out how to back up 
before something horrible happens to your valuable data!

I strongly recommend that you read Chapter 24 sooner rather than later — 
preferably before you do any significant work on your Mac. Dr. Mac says, 
“There are only two kinds of Mac users: Those who have lost data and those 
who will.” Which kind do you want to be?



CHAPTER 1  macOS Mojave 101 (Prerequisites: None)      17

»» Don’t kiss your monitor while wearing stuff on your lips. For obvious 
reasons! Use a clean, soft microfiber cloth and OmniCleanz display cleaning 
solution (I love the stuff, made by RadTech; www.radtech.com) to clean your 
display.

Definitely do not use household window cleaners or paper towels. Either one 
can harm your display. Use a soft clean cloth (preferably microfiber), and if 
you’re going to use a cleaner, make sure it’s specifically designed not to harm 
computer displays. Finally, spray the cleaner on the cloth, not on the screen.

Point-and-click Boot Camp
Are you new to the Mac? Just figuring out how to move the mouse around? Now is 
a good time to go over some fundamental stuff that you need to know for just 
about everything you’ll be doing on the Mac. Spend a few minutes reading this 
section, and soon you’ll be clicking, double-clicking, pressing, and pointing all 
over the place. If you think you have the whole mousing thing pretty much figured 
out, feel free to skip this section. I’ll catch you on the other side.

Still with me? Good. Now for some basic terminology:

»» Point: Before you can click or press anything, you have to point to it. Place 
your hand on your mouse, and move it so that the cursor arrow is over the 
object you want — such as on top of an icon or a button.

If you’re using a trackpad, slide your finger lightly across the pad until the 
cursor arrow is over the object you want.

»» Click: Also called single click. Use your index finger to push the mouse button 
(or the left mouse button if your mouse has more than one) all the way down 
and then let go so that the button (usually) produces a satisfying clicking 
sound. (If you have one of the optical Apple Pro mice, you push the whole 
thing down to click.) Use a single click to highlight an icon, press a button, or 
activate a check box or window.

In other words, first you point and then you click — point and click, in com-
puter lingo.

If you’re using a trackpad, press down on it to click.

»» Double-click: Click twice in rapid succession. With a little practice, you can 
perfect this technique in no time. Use a double-click to open a folder or to 
launch a file or application.

Trackpad users: Press down on the pad two times in rapid succession.

https://www.radtech.com
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»» Control-click: Hold down the Control key while single-clicking. (Also called 
secondary-click or right-click.)

Trackpad users can either hold down the Control key while pressing down on 
the pad with one finger, or tap the trackpad with two fingers without holding 
down the Control key.

If tapping your trackpad with two fingers didn’t bring up the little menu, check 
your Trackpad System Preferences pane (see Chapter 6).

Control-clicking — the same as right-clicking on a Windows system — displays 
a menu (called a contextual or shortcut menu). In fact, if you’re blessed with a 
two-or-more-button mouse (such as the Apple Magic Mouse), you can 
right-click and avoid having to hold down the Control key. (You may have to 
enable this feature in the Mouse System Preferences pane.)

»» Drag: Dragging something usually means you have to click it first and hold 
down the mouse or trackpad button. Then you move the mouse on your desk 
or mouse pad (or your finger on the trackpad) so that the cursor and what-
ever you select moves across the screen. The combination of holding down 
the button and dragging the mouse is usually referred to as clicking and 
dragging.

»» Wiggle (or jiggle): This welcome improvement, introduced in El Capitan (and 
terrific if I do say so myself) is awesome when you lose track of the pointer on 
your screen. Just wiggle your mouse back and forth (or jiggle your finger back 
and forth on the trackpad) for a few seconds and the pointer will magically get 
much bigger, making it easier to see on the screen. And, of course, when you 
stop wiggling or jiggling, the pointer returns to its normal size.

»» Choosing an item from a menu: To get to macOS menu commands, you 
must first open a menu and then choose the option you want. Point at the 
name of the menu you want with your cursor, press the mouse button, and 
then drag downward until you select the command you want. When the 
command is highlighted, finish selecting by letting go of the mouse button.

If you’re a longtime Mac user, you probably hold down the mouse button the 
whole time between clicking the name of the menu and selecting the command 
you want. You can still do it that way, but you can also click the menu name to 
open it, release the mouse button, point at the item you want to select, and then 
click again. In other words, macOS menus stay open after you click their names, 
even if you’re not holding down the mouse button. After you click a menu’s name 
to open it, you can even type the first letter (or letters) of the item to select it and 
then execute that item by pressing the spacebar or the Return key. Furthermore, 
menus remain open until you click something else.

Go ahead and give it a try . . . I’ll wait.
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The terms given in the preceding list apply to all Mac laptop, desktop, and tower 
systems. If you use a MacBook, MacBook Pro, MacBook Air, or Apple Magic Track-
pad, however, you’ll want to add to your lexicon a few more terms — such as tap, 
swipe, rotate, pinch, and spread. You can read all about them in Chapters 2 and 13.

Not Just a Beatles Movie:  
Help and the Help Menu

One of the best features of all Macs is the excellent built-in help, and macOS 
Mojave doesn’t cheat you on that legacy: This system has online help in abun-
dance. When you have a question about how to do something, Help Center is the 
first place you should visit (after this book, of course).

Clicking the Help menu reveals the Search field at the top of the menu and the 
macOS Help item. Choosing MacOS Help opens the Mac Help window, as shown in 
Figure 1-5.

Although the keyboard shortcut for Help no long appears on the Help menu, the 
same shortcut as always, Shift+⌘  +?, still opens Help.

FIGURE 1-5: 
Mac Help is 

nothing if not 
helpful.
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You can browse Help by clicking a topic in the Table of Contents and then clicking 
a subtopic. If you don’t see the Table of Contents, click the Table of Contents but-
ton, labeled in Figure 1-5.

To search Mac Help, simply type a word or phrase in either Search field — the one 
in the Help menu itself or the one near the top of the Help window on the right 
side — and then press Return. In a few seconds, your Mac provides one or more 
articles to read, which (theoretically) are related to your question. Usually. If you 
type menus and press Return, for example, you get the results shown in 
Figure 1-6.

As long as your Mac is connected to the Internet, search results include articles 
from the Apple online support database.

Although you don’t have to be connected to the Internet to use Mac Help, you do 
need an Internet connection to get the most out of it. (Chapter 15 can help you set 
up an Internet connection, if you don’t have one.) That’s because macOS installs 
only certain help articles on your hard drive. If you ask a question that those 
articles don’t answer, Mac Help connects to the Apple website and downloads 
the answer (assuming that you have an active Internet connection). These answers 
appear when you click Show All near the bottom of Figure 1-6. Click one of these 
entries, and Help Viewer retrieves the text over the Internet. This is sometimes 
inconvenient but also quite smart, because Apple can update the Help system at 
any time without requiring any action from you.

FIGURE 1-6: 
You have 

questions? 
Mac Help 

has answers.
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Furthermore, after you ask a question and Mac Help has grabbed the answer from 
the Apple website, the answer remains on your hard drive forever. If you ask for it 
again — even at a later date — your computer won’t have to download it from the 
Apple website again.

Click Search the Web for More Results (refer to the bottom of Figure 1-6) to launch 
Safari and perform a web search for the phrase you typed.

macOS also has a cool feature I like to call automatic visual help cues. Here’s how 
they work:

1.	 In the Help menu’s Search field, type a word or phrase.

2.	 Select any item that has a menu icon to its left (such as the items with 
Trash in their names in Figure 1-7).

The automatic visual cue — an arrow — appears, pointing at that command in 
the appropriate menu.

Finally, don’t forget that most apps have their own Help systems, so if you want 
general help with your Mac, you need to first click the Finder icon in the dock, 
click the desktop, or use the app-switching shortcut ⌘    +Tab to activate Finder. 
Only then can you choose Mac Help from the Finder’s Help menu.

FIGURE 1-7: 
If you choose an 

item with a menu 
icon, an arrow 
points to that 

item in context.
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Chapter 2
Desktop and Windows 
and Menus (Oh My!)

This chapter introduces important features of macOS, starting with the first 
things you see when you log in: Finder and its desktop. After a quick look 
around the desktop, you get a look into two of its most useful features: win-

dows and menus.

Windows are (and have always been) an integral part of Mac computing. Windows 
in Finder (or, as a PC user would say, “on the desktop”) show you the contents of 
the hard drive, optical drive, flash (thumb) drive, network drive, disk image, and 
folder icons. Windows in applications do many things. The point is that windows 
are part of what makes your Mac a Mac; knowing how they work — and how to 
use them — is essential.

Menus are another quintessential part of the Mac experience. The latter part of 
this chapter starts you out with a few menu basics. As needed, I direct you to other 
parts of the book for greater detail. So relax and don’t worry. By the end of this 
chapter, you’ll be ready to work with windows and menus in any application that 
uses them (and most applications, games excluded, do).

IN THIS CHAPTER

»» Understanding Finder

»» Checking out the parts of a window

»» Dealing with dealie-boppers in 
windows

»» Resizing, moving, and closing 
windows

»» Getting comfortable with menu 
basics
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Touring Finder and Its Desktop
Finder is the program that creates the desktop, keeps track of your files and folders, 
and is always running. Just about everything you do on your Mac begins and ends 
with Finder. It’s where you manage files, store documents, launch programs, and 
much more. If you ever expect to master your Mac, the first step is to master 
Finder and desktop. (The default Mojave Finder and desktop appear in the preced-
ing chapter.)

Finder is the center of your macOS experience, so before I go any further, here’s a 
quick description of its most prominent features:

»» Desktop: The desktop is the area behind the windows and the dock.  
In macOS 10.14, the default desktop picture again honors its namesake, 
showing a portion of the Mojave desert.

It’s also where your hard drive icon (ordinarily) lives, although if you bought a 
new Mac with Mojave preinstalled, there won’t be any icons on the desktop.

If you don’t see your disk icon(s), and you’re old-school like me and prefer 
to always see disk icons on your desktop, never fear — you learn how to 
enable this behavior in Chapter 4.

The desktop isn’t a window, yet it acts like one. Like a folder window or a disk 
window, the desktop can contain icons. But unlike most windows, which 
require a bit of navigation to get to, the desktop is always there behind 
any open windows, making it a great place for icons you use a lot, such as 
oft-used folders, applications, or documents.

Some folks use the terms desktop and Finder interchangeably to refer to the 
total Mac environment you see after you log in — the icons, windows, menus, 
and all that other cool stuff. Just to make things confusing, the background 
you see on your screen — the picture behind your hard drive icon and 
your open windows — is also called the desktop. In this book, I refer to 
the application you use when the desktop is showing as Finder. When I say 
desktop, I’m talking about the picture background behind your windows 
and the dock, which you can use as a storage place for icons if you like.

To make things even more confusing, the desktop is a full-screen representa-
tion of the icons in the Desktop folder inside your Home folder. Don’t panic. 
The desktop metaphor used by Mojave will become crystal clear in upcoming 
pages and chapters.

»» Dock: The dock is Finder’s main navigation shortcut tool. It makes getting to 
frequently used icons easy, even when you have a screen full of windows. Like 
the desktop, the dock is a great place for the folders, applications, and specific 
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documents you use most. Besides putting your frequently used icons at your 
fingertips, it’s extremely customizable; read more about it in Chapter 3.

»» Icons: Icons are the little pictures you see in your windows and even on your 
desktop. Icons represent the things you work with on your Mac, such as 
applications (programs), documents, folders, utilities, and more.

»» Windows: Opening most icons (by double-clicking them) makes a window 
appear. Windows in Finder show you the contents of hard drive and folder 
icons; windows in applications usually show the contents of documents.  
In the sections that follow, you can find the full scoop on Mojave windows.

»» Menus: Menus let you choose to do things, such as create new folders; 
duplicate files; and cut, copy, or paste text. I introduce menu basics later 
in this chapter in the “Menu Basics” section; you find details about working 
with menus for specific tasks throughout this book.

Whereas this chapter offers a basic introduction to Finder and desktop, Chapter 8 
explains in detail how to navigate and manage your files in Finder. But before you 
start using Finder, it helps to know the basics of working with windows and 
menus; if these Mac features are new to you, I suggest that you read this entire 
chapter now and pay special attention to Chapter 8 later.

Anatomy of a Window
Windows are a ubiquitous part of using a Mac. When you open a folder, you see 
a window. When you write a letter, the document that you’re working on appears 
in a window. When you browse the Internet, web pages appear in a window . . . and 
so on.

For the most part, windows are windows from program to program. You’ll proba-
bly notice that some programs (Adobe Photoshop or Microsoft Word, for example) 
take liberties with windows by adding features such as custom toolbars or textual 
information (such as zoom percentage or file size) around the edges of the 
document window and in toolbars.

Don’t let it bug you; that extra fluff is just window dressing (pun intended). Main-
taining the window metaphor, many information windows display different kinds 
of information in different panes, or discrete sections within the window.

When you finish this chapter, which focuses exclusively on macOS Finder windows, 
you’ll know how to use most windows in most applications.
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And so, without further ado, the following list gives you a look at the main fea-
tures of a typical Finder window (as shown in Figure 2-1). I discuss these features 
in greater detail in later sections of this chapter.

If your windows don’t look exactly like the one shown in Figure 2-1, don’t be con-
cerned. You can make your windows look and feel any way you like. As I explain 
later in the “Working with Windows” section, moving and resizing windows are 
easy tasks.

Meanwhile, here’s what you see on the toolbar (clockwise from top left):

»» Close, Minimize, and Zoom buttons: Shut ’em, shrink ’em, and grow ’em.

»» View buttons: Choose among four exciting views of your window: Icon, List, 
Column, and the new Gallery view. Find out more about views in Chapter 4.

»» Arrange menu: Click this little doohickey to arrange this window’s icons by 
Name, Kind, Application, Date Modified, Date Created, Date Last Opened, 
Date Added, Size, or Tags. Or, of course, by None, which is the default.

FIGURE 2-1: 
A typical Finder 

window in 
macOS Mojave.
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»» Action menu: This button is really a pop-up menu of commands you can 
apply to currently selected items in the Finder window or on the desktop. 
(These are generally the same commands you’d see in the Contextual menu 
if you right-clicked or Control-clicked the same items.)

»» Window title: Shows the name of the window (mojavebob in Figure 2-1).

⌘    -click (or Control-click) the window title to see a pop-up menu with the 
complete path to this folder (try it). This tip applies to most windows you’ll 
encounter, not just Finder windows. So ⌘    - or Control-click a window’s title 
(a right-click or two-fingered tap on a trackpad will work, too), and you’ll 
usually see the path to its enclosing folder on your disk.

You can also choose to have the path displayed at the bottom of every Finder 
window by choosing View ➪ Show Path Bar.

»» Share menu: Another button that’s actually a menu. Click it to share selected 
files or folders via email, Messages, AirDrop, or Notes.

»» Tags menu: Yet another button/menu; click it to assign a tag to the selected 
files or folders.

»» Search field: Type a string of characters here, and macOS Mojave digs into 
your system to find items that match by filename or document contents 
(yes, words within documents).

»» Scroll bars: Use the scroll bars for moving around a window.

»» Sidebar: Frequently used items live here.

»» Forward and Back buttons: These buttons take you to the next or previous 
folder, respectively, displayed in this particular window.

Just as with web browsers, the Forward and Back buttons in the Finder 
work the same way. The first time you open a window, neither button is 
active (as shown in Figure 2-1). But as you navigate from folder to folder, 
these buttons remember your breadcrumb trail so you can quickly traverse 
backward or forward, window by window. You can even navigate this way 
from the keyboard by using the shortcuts ⌘    +[ for Back and ⌘    +] for Forward.

The Forward and Back buttons remember only the other folders you’ve visited 
that appear in that open window.

In other words, if you’ve set a Finder preference so that folders always open 
in a new window — or if you forced a folder to open in a new window, which 
I describe in a bit — the Forward and Back buttons won’t work.

You have to use the modern, macOS-style window option, which uses a single 
window, or the buttons are useless.
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Top o’ the window to ya!
Take a gander at the top of a window — any window. You see three buttons in the 
top-left corner and the name of the window in the top center. The three buttons 
(called gumdrop buttons by some folks because they look like, well, gumdrops) are 
officially known as Close, Minimize, and Zoom, and their colors (red, yellow, and 
green, respectively, unless you’ve switched to the Graphite appearance in the 
General System Preferences pane as described in Chapter 6) pop off the screen. 
Here’s what they do:

»» Close (red): Click this button to close the window.

»» Minimize (yellow): Click this button to minimize the window. Clicking Minimize 
appears to close the window, but instead of making it disappear, Minimize 
adds an icon for the window to the right side of the dock.

See the section about minimizing windows into application icons in Chapter 3 
if a document icon doesn’t appear in your dock when you minimize the 
document’s window.

To view the window again, click the dock icon for the window that you 
minimized. If the window happens to be a QuickTime movie, the movie audio 
continues to play and a tiny still image from the video appears as its icon in 
the dock. (I discuss the dock in detail in Chapter 3.)

»» Zoom (green): Click a window’s green Zoom button, and the window expands 
to cover the whole screen, including the menu bar.

If you prefer the old behavior, where a window zoomed to the largest size it 
could but didn’t cover the full screen, hold down the Option key when you 
click the green button.

To shrink the window back to its previous dimensions, slide the cursor up to 
the very top of the screen, wait for the menu bar to appear, and then click the 
green Zoom button.

Another way to escape from a full-screen window, at least in Finder, is to 
press the Esc key on your keyboard. Sadly, this trick doesn’t work with all apps, 
though it’s quite useful in apps that support it (most Apple apps and many 
others) as well as in Finder.

El Capitan (OS X 10.11) introduced a feature called Split View to the green 
gumdrop button. To see Split View in action, press the green button for a 
moment (that is, perform the first half of a click but don’t release the button 
yet). Half the screen turns light blue. Without releasing the mouse button, 
drag to the left or right; the blue tint moves to the left or right side of the 
screen. Release the mouse button and the window fills the blue half of the 
screen. The other half of the screen displays miniature versions of all open 
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windows. Hover the cursor over a miniature window to see its name; click a 
miniature window and it fills that half of the screen.

To work in Split View, click either window to activate it and do what you have 
to do. To activate the other window, click it. To exit Split View, do one of the 
following:

•	 Press Esc.

•	 Move the pointer to the top of the screen; when the buttons (for both 
windows) reappear, click any button.

•	 Quit either application.

My colleague at The Mac Observer, John Martellaro, called Split View silly, but 
I’m not so sure. I use it for certain tasks (assuming I remember that it’s hiding 
under the green gumdrop button).

A scroll new world
Yet another way to see more of what’s in a window or pane is to scroll through it. 
Scroll bars appear at the bottom and right sides of any window or pane that 
contains more stuff — icons, text, pixels, or whatever — than you can see in the 
window. Figure 2-2, for example, shows two instances of the same window: Drag-
ging the scroll bar on the right side of the smaller window would reveal the icons 
above and below the six (whole) icons that are currently visible. Dragging the 
scroll bar on the bottom of the smaller window would reveal items to the left and 
right of the six that are currently visible.

Simply click and drag a scroll bar to move it up or down or side to side.

If your scroll bars don’t look exactly like the ones in Figure  2-2 or work as 
described in the following list, don’t worry. These are System Preferences you can 
configure to your heart’s desire, as you discover in Chapter 6.

Here are some ways you can scroll in a window:

»» Click a scroll bar and drag. The content of the window scrolls proportionally 
to how far you drag the scroll bar.

»» Click in the scroll bar area but don’t click the scroll bar itself. The window 
scrolls either one page up (if you click above the scroll bar) or down (if you 
click below the scroll bar). You can change a setting in your General System 
Preferences pane to cause the window to scroll proportionally to where  
you click.
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For what it’s worth, the Page Up and Page Down keys on your keyboard 
function the same way as clicking the white scroll area (the vertical scroll bar 
only) in Finder and many applications. These keys don’t work in every program, 
though, so don’t become too dependent on them. Also, if you purchased a 
mouse, a trackball, or another pointing device that has a scroll wheel, you can 
scroll vertically in the active (front) window with the scroll wheel or press and 
hold down the Shift key to scroll horizontally. Alas, this horizontal scrolling- 
with-the-Shift-key works in Finder windows but not in all applications. For 
example, it works in the Apple TextEdit application, but not in Microsoft Word.

»» Use the keyboard. In Finder, first click an icon in the window and then use 
the arrow keys to move up, down, left, or right. Using an arrow key selects the 
next icon in the direction it indicates — and automatically scrolls the window, 
if necessary. In other programs, you might or might not be able to use the 
keyboard to scroll. The best advice I can give you is to try it — either it will 
work or it won’t.

»» Use a two-finger swipe (on a trackpad). If you have a notebook with 
a trackpad or use a Magic Trackpad or Magic Mouse, just move the  
arrow cursor over the window and then swipe the trackpad with two 
fingers to scroll.

FIGURE 2-2: 
The same window 

twice. Use the 
scroll bars in the 
front window to 

see the icons 
above, below, 
to the left, or 

to the right.
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(Hyper)active windows
To work within a window, the window must be active. The active window is always 
the frontmost window, and inactive windows always appear behind the active 
window. Only one window can be active at a time. To make a window active, click 
it anywhere — in the middle, on the title bar, or on a scroll bar. It doesn’t matter 
where; just click anywhere to activate it.

The exceptions are the Close, Minimize, and Zoom buttons on inactive windows, 
which always do what they do, regardless of whether a window is active or inactive.

Look at Figure 2-3 for an example of an active window in front of an inactive 
window (the Applications window and the Utilities window, respectively).

The following is a list of the major visual cues that distinguish active from inactive 
windows:

»» The active window’s title bar: By default, the Close, Minimize, and Zoom 
buttons are bright red, yellow, and green, respectively and the inactive 
windows’ buttons are light gray.

This is a nice visual cue. Colored items are active, and gray ones are inactive. 
Better still, if you move your mouse cursor over an inactive window’s gum-
drop buttons, they light up in their usual colors so you can close, minimize, 
or zoom an inactive window without first clicking it to making it active. Neat!

FIGURE 2-3: 
An active window 

in front of an 
inactive window.
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»» The active window’s toolbar: Toolbar buttons are darker and more distinc-
tive; the inactive window’s toolbar buttons are light gray and more subdued.

»» The active window’s drop shadow: Notice how the active window has a 
more prominent shadow? This tricks your eye into thinking the active window 
is in front of the inactive one.

One last thing: If you’re wondering how to resize a window, just hover the cursor 
over a window’s edge or corner or over the dividing line between two panes in the 
same window (such as the sidebar and the main area of Finder windows). A help-
ful little arrow appears as a visual cue that you can now drag the edge, corner, or 
dividing line to resize the window or pane.

Dialog Dealie-Boppers
Dialogs are special windows that pop up over the active window. You generally see 
them when you select a menu item that ends in an ellipsis (. . .).

Dialogs can contain a number of standard Mac features (I call them dealie- 
boppers), such as radio buttons, pop-up menus, tabs, text-entry fields, and check 
boxes. You see these features again and again in dialogs. Take a moment to look at 
each of these dealie-boppers in Figure 2-4.

»» Radio buttons: Radio buttons are so named because, like the buttons on your 
car radio (if you have a very old car), only one at a time can be active. (When 
they’re active, they appear to be pushed in, just like the old radio buttons.) 
Radio buttons always appear in a group of two or more; when you select one, 
all the others are automatically deselected.

Here’s a nifty and undocumented shortcut: You can usually select check boxes 
and radio buttons by clicking their names (instead of the buttons or boxes).

»» Tabs: When a dialog contains more information than can fit in a single 
window, the info may be divided among panes denoted by tabs. In Figure 2-4, 
the New Document tab is selected on the left, and the Open and Save tab is 
selected on the right.

»» Pop-up menus: These menus are appropriately named because they pop up 
when you click them. In Figure 2-4, right, the Styling menu has been clicked 
and is popped up; the other pop-up menus — Opening Files, Saving Files, 
Document Type, and Encoding (mostly obscured by the popped-up Styling 
menu) — are unclicked and unpopped.
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You can always recognize a pop-up menu because it appears in a slightly 
rounded rectangle and has a double-ended arrow symbol (or a pair of 
triangles, if you like) on the right.

Have you figured out yet what radio buttons, tabs, and pop-up menus have in 
common? Hint: All three enable you to make a single selection from a group of 
options. (Well, okay, that was more of an answer than a hint.)

»» Text-entry fields: In text-entry fields, you type text (including numbers) from 
the keyboard. In Figure 2-4, left, the Width, Height, Author, Organization, and 
Copyright options are text-entry fields.

»» Check boxes: The last dealie-bopper that you see frequently is the check box. 
In a group of check boxes, you can select as many options as you like. Check 
boxes are selected when they contain a check mark, and they’re deselected 
when they’re empty, as shown in Figure 2-4.

I couldn’t find a dialog or window that included all the aforementioned dealie-
boppers as well as the one other dealie-bopper you should become familiar with, 
the disclosure triangle. If you see a triangle in a dialog or sheet, try clicking it. If 
it’s a disclosure triangle, it will reveal additional options (or its contents if it’s a 
folder in Finder’s List view, as you see in Chapter 8).

FIGURE 2-4: 
This window 

offers most of the 
dealie-boppers 

you’re ever likely 
to encounter.
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Some applications have tri-state check boxes (and no, I’m not talking geography 
here). These special check boxes are empty when nothing in the group is selected, 
sport an X when everything in the group is selected, and sport a minus sign (–) 
when some items in the group are selected and some are not.

Working with Windows
In the following sections, I give you a closer look at windows themselves: how you 
move them, size them, and use them. And although Mojave windows are similar 
to windows you’ve used in other versions of macOS (and even, dare I say it, 
Windows), you may just discover a new wrinkle or two.

If you’re relatively new to the Mac, you may want to read this section while sitting 
at your computer, trying the techniques as you read them. Most people find it 
easier to remember something they’ve read if they actually do it. If you’ve been 
using your Mac for a while, you’ve probably figured out how windows work by now.

Opening and closing windows
To start peering into windows on your Mac, first you need to know how to open 
and close them. When you’re working in Finder, you can choose the following 
commands from the File menu. Note that you’ll probably find similar commands 
on the File menu of programs other than Finder.

You’ll use many of these commands frequently, so it would behoove you to mem-
orize the keyboard shortcuts. If you’re not sure how keyboard shortcuts work, 
check out “Using keyboard shortcut commands,” later in this chapter.

»» New Finder Window (⌘    +N): Opens a new Finder window. In other pro-
grams, ⌘    +N might open a new document, project, or whatever that program 
helps you create.

»» Open (⌘    +O): Opens the selected item, be it an icon, a window, or a folder.

»» Close Window (⌘   +W): Closes the active window. If no windows are open or if 
no window is selected, the Close Window command appears grayed and can’t 
be chosen. Or if you prefer, you can close a window by clicking the red Close 
button in the top-left corner.

If you hold down the Option key with the File menu open, the Close Window 
command changes to Close All. This useful command enables you to close all 
open Finder windows. But it shows up only when you press the Option key or 
use its keyboard shortcut (⌘    +Option+W); otherwise, it remains hidden.
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Note that several other commands in the File menu transmogrify when you 
press the Option key. It would be off topic to get into them here, but here’s a 
tip: Press the Option key, and browse all Finder menus. At least a dozen useful 
commands appear only when the Option key is pressed. Press it early and 
often for hidden (often time-saving) commands.

Resizing windows and window panes
If you want to see more (or less) of what’s in a window, just hover the pointer over 
any edge or corner and drag. When the cursor turns into a little double-headed 
arrow, as shown in Figure 2-5, click and drag to resize the window.

Note that I’ve put arrow cursors on all sides and corners of the window in 
Figure  2-5. That’s for illustration purposes; in real life you’ll only see one at 
a time.

Display windows, like those in Finder, frequently consist of multiple panes. If you 
look at Figure 2-5, a line divides the sidebar pane to the left of it and the contents 
pane to the right. When your mouse pointer hovers over the line, the cursor 
changes to a vertical bar (or it could be horizontal if the panes are one above the 
other) with little arrows pointing out of both sides, as shown in the margin.

When you see this cursor, you can click and drag anywhere in the dividing line 
that separates the sidebar from the rest of the window. Doing so resizes the two 
panes relative to each other; one gets larger and one gets smaller.

FIGURE 2-5: 
Hover the pointer 

over any corner 
or edge; when 

the double-
headed arrow 

(resizer) cursor 
appears, click 

and drag to 
resize the 

window.
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Moving windows
To move a window, click anywhere in a window’s gray title bar or toolbar (except 
on a button, menu, or Search field) and drag the window to wherever you want it. 
The window moves wherever you move the mouse, stopping dead in its tracks 
when you release the mouse button.

If you can’t find the cursor on the screen, wiggle your finger on the trackpad or 
jiggle the mouse. In Mojave, these movements magnify the pointer to make it 
easier to find onscreen.

Shuffling windows
I’ve already spent plenty of pages giving you the scoop on how to work with 
windows. But wait. There’s more! The commands on the Window menu provide 
tools you can use to manage your windows.

Here is a brief look at each of the items on the Window menu. (And if you’re unfa-
miliar with menus and keyboard shortcuts, you find out how they work later in 
this chapter.)

»» Minimize (⌘   +M): Use this command to minimize the active Finder window 
to the dock and unclutter your desktop. It’s the same as clicking the yellow 
gumdrop button.

»» Zoom: This command does the same thing as the green gumdrop button. 
If you’ve forgotten what the green gumdrop does already, just turn back a 
few pages to the “Top o’ the window to ya!” section and read it again.

»» Cycle through Windows (⌘    +`): Each time you choose this command or use 
the keyboard shortcut for it, a different window becomes active. So if you 
have three windows — call ’em Window 1, Window 2, and Window 3 — and 
you’re using Window 1, this command deactivates Window 1 and activates 
Window 2. If you choose it again, the command deactivates Window 2 and 
activates Window 3. Choose it one more time, and it deactivates Window 3 
and reactivates Window 1.

The next four commands in the Window menu help you manage Mojave Finder 
window tabs (which were introduced in OS X 10.9 Mavericks). If you’re a fan of 
tabbed browsing (à la Safari), you’ll love tabs in a Finder window.

Tabs let you view multiple folders or disks or both in a single window, with each 
folder or disk in its own tab, as shown in Figure 2-6.
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Tabbed windows are an ingenious way to cram a lot of information into a little 
space. I’ve tried a number of third-party utilities that purported to provide tabbed 
Finder windows, but I’ve never found one that’s reliable and robust enough to 
continue using. This one, on the other hand, just works.

Mojave, like its predecessor, includes system-wide tabbed windows, which should 
work in almost every application that uses windows. The cool part is the app 
doesn’t have to be updated in any way  — Mojave grafts tabbed windows onto 
almost every app that displays multiple windows, as shown in Figure 2-7.

The remaining commands in the Window menu are as follows:

»» Show Previous Tab (Control+Shift+Tab): Each time you choose this com-
mand or use its keyboard shortcut, the previous tab — the one to its left, 
unless it’s the leftmost tab — becomes active. For example, in Figure 2-6, 
Documents is the active tab. Use this command, and Applications becomes 
the active tab. Use it a third time, and Downloads becomes active. Because 
Downloads is the leftmost tab, if you use this command yet again, it wraps 
around and Documents becomes the active tab again.

»» Show Next Tab (Control+Tab): Same as Show Previous Tab except in reverse. 
Instead of showing the previous tab (the one to the left), this command shows 
the next tab (the one to the right). Use this command three times in a row 
(refer to the order shown in Figure 2-6), and you see the Downloads tab, then 
the Applications tab, and finally the Documents tab again.

»» Move Tab to New Window (no keyboard shortcut): Does just what it says; 
it moves the active tab into a new window of its own.

FIGURE 2-6: 
I can view the 

contents of my 
Documents, 

Applications, 
or Downloads 

folder by merely 
clicking the 

appropriate tab.


